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Introduction
Cisco Unified Messaging with IBM Lotus Sametime allows users to view and play Cisco Unity or 
Cisco Unity Connection voice messages directly from their Sametime client application.

In addition, IBM Lotus Notes versions 8.0.1 and later integrate Sametime features to achieve the 
following features:

• Sametime shows up in a pane within the Notes client.
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  System Requirements
• The native capabilities of Sametime—as well as Cisco Unified Messaging with Lotus Sametime 
features—can be accessed from within Notes.

System Requirements
Before installing Cisco Unified Messaging with IBM Lotus Sametime, user workstations must meet the 
following minimum requirements: 

• A supported operating system—see “Client Platforms” in the following section, “Compatibility 
Information.”

• 512 MB of RAM.

• 20 MB of free disk space.

• One of the following applications:

– IBM Lotus Notes version 8.0.1 or later (including integrated Sametime features)

– IBM Lotus Sametime version 8.0.1 or later

Compatibility Information
Cisco Unified Messaging with IBM Lotus Sametime is supported for use with the following:

Cisco Unified Messaging Systems

• Cisco Unity

– Version 8.0 with Microsoft Exchange

– Version 7.0 with IBM Lotus Domino

– Version 7.0 with Microsoft Exchange

– Version 5.0 with IBM Lotus Domino

– Version 5.0 with Microsoft Exchange

• Cisco Unity Connection

– Version 8.5

– Version 8.0

– Version 7.x

– Version 2.1

Client Platforms

• Apple

– Mac OS X 10.6.x

– Mac OS X 10.5.x

– Mac OS X 10.4.x
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  Related Documentation
• Microsoft 

– Windows 7 Enterprise, Professional, and Ultimate editions 

– Windows Vista Business and Enterprise editions (MSDN version is not supported.)

– Windows XP (Service Pack 2 and later)

• Novell

– SUSE Linux Enterprise Desktop version 10

– SUSE Linux Enterprise Desktop version 11

– Linux Desktop version 9

• Red Hat Enterprise Linux version 4

• Red Hat Enterprise Linux version 5

Note Use of the voicemail plugin on Red Hat Enterprise Linux is only supported with the IBM Lotus 
Sametime 8.0(2) standalone client.

IBM Lotus Clients

– IBM Lotus Notes version 8.0.1 and later (including integrated Sametime features)

– IBM Lotus Sametime version 8.0.1 and later

Note If you are using secure messaging, Lotus Sametime versions 8.0.1, 8.0.2,and 8.5 require 
hotfixes; version 8.5.1 does not. (See also the “Applying IBM Hotfixes for Lotus Sametime 
8.0.1 and 8.5 (Secure Messaging Only)” section on page 6.) 

Determining the Software Version

To Determine the Cisco Unified Messaging with IBM Lotus Sametime Version in Use

Step 1 From the File menu, select Preferences. 

Step 2 In the left pane, expand the Cisco tab.

Step 3 Under Cisco, select Voicemail.

The Cisco Unified Messaging with Lotus Sametime version is displayed underneath the “Voicemail” 
label at the top of the page.

Related Documentation
The User Guide for Cisco Unified Messaging Release 8.x with IBM Lotus Sametime is available at 
http://www.cisco.com/en/US/products/ps9830/products_user_guide_list.html.
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  New and Changed Requirements and Support—Release 8.5(1)
New and Changed Requirements and Support—Release 8.5(1)
This section contains information about new and changed requirements and support in the 8.5(1) time 
frame only.

(For information on new and changed requirements and support in earlier versions of Cisco Unified 
Messaging with IBM Lotus Sametime, see the applicable release notes at 
http://www.cisco.com/en/US/products/ps9830/prod_release_notes_list.html.)

Cisco Unified Messaging Systems
With this release, the following Cisco unified messaging systems have been added to the list of supported 
systems for use with Cisco Unified Messaging with Lotus Sametime:

• Cisco Unity Connection version 8.5

IBM Lotus Client Applications
With this release, the following IBM Lotus client applications have been added to the list of supported 
applications for use with Cisco Unified Messaging with Lotus Sametime:

• IBM Lotus Notes version 8.5.2

New and Changed Functionality—Release 8.5(1)
A notification window is automatically displayed when voicemail credentials are incorrect. This 
notification window will inform the user of the incorrect credentials. A link to the Preferences page is 
provided where the incorrect credentials can be updated.

(For information on new and changed functionality in earlier versions of Cisco Unified Messaging with 
IBM Lotus Sametime, see the applicable release notes at 
http://www.cisco.com/en/US/products/ps9830/prod_release_notes_list.html.)

Installation and Upgrade Information
• Downloading Cisco Unified Messaging 8.5(1) with IBM Lotus Sametime Software, page 5

• Applying IBM Hotfixes for Lotus Sametime 8.0.1 and 8.5 (Secure Messaging Only), page 6

• Applying IBM Hotfixes for Lotus Sametime 8.0.2 (Secure Messaging Only), page 6

• Upgrading to Cisco Unified Messaging 8.5(1) with IBM Lotus Sametime, page 7

• Installing Cisco Unified Messaging 8.5(1) with IBM Lotus Sametime, page 7

• Configuring Cisco Unified Messaging 8.5(1) with IBM Lotus Sametime, page 8
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  Installation and Upgrade Information
Downloading Cisco Unified Messaging 8.5(1) with IBM Lotus Sametime 
Software

Do the following two procedures in the order listed.

To Download Cisco Unified Messaging 8.5(1) with IBM Lotus Sametime

Step 1 On the web server that is going to host the update site, create a folder to hold the Cisco Unified 
Messaging with IBM Lotus Sametime files.

Step 2 On a computer with a high-speed Internet connection, go to the Unified Communications Plug-ins for 
IBM Lotus Sametime Software software download page at 
http://tools.cisco.com/support/downloads/go/Redirect.x?mdfid=282224966.

Note To access the software download page, you must be signed in to Cisco.com as a registered user.

Step 3 On the Select a Release page, expand Latest Releases, then select 8.5(1). The download button appears 
on the right side of the page.

Step 4 Confirm that the computer you are using has sufficient hard-disk space for the downloaded file. (The 
download file size appears in the download description.)

Step 5 Download the file Cisco_Plugins_8.5.1.zip to the folder you created in Step 1.

Step 6 Follow the on-screen prompts to complete the download.

Step 7 Open the folder you created in Step 1.

Step 8 From the Cisco_Plugins_8.5.1.zip file, extract the CiscoUMWithLotusST_8.5.1.1025.zip file by using 
the application appropriate for the operating system.

Step 9 Open the CiscoUMWithLotusST_8.5.1.1025.zip\UpdateSite directory that was created from the 
extracted file.

When extracted, the directory structure for Cisco Unified Messaging with IBM Lotus Sametime looks 
like this:

- features
- plugins
- web
index.html
site.xml

To Extract the Cisco Unified Communications with IBM Lotus Sametime Configuration Tool

Step 1 Go to the directory where you downloaded the Cisco_Plugins_8.5.1.zip file in the “To Download Cisco 
Unified Messaging 8.5(1) with IBM Lotus Sametime” procedure on page 5.

Step 2 From the Cisco_Plugins_8.5.1.zip file, extract the CiscoCfg-8.5.1.119.zip file by using the application 
appropriate for the operating system.
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When extracted, the directory structure for the Cisco Unified Communications with IBM Lotus 
Sametime Configuration Tool looks like this:

- ciscocfg
- templates

Applying IBM Hotfixes for Lotus Sametime 8.0.1 and 8.5 (Secure Messaging 
Only)

Note The IBM hotfixes apply only to Lotus Sametime 8.0.1 or 8.5 depending on version in use.

Do the procedure in this section only when secure messaging is configured.

To Apply IBM Hotfixes for Lotus Sametime 8.0.1 or 8.5 (Secure Messaging Only)

Step 1 Go to the IBM website: http://www.ibm.com/support/docview.wss?rs=899&uid=swg21414050.

Step 2 Open a service request with IBM Support to obtain the hotfix as noted on the site. Include the version 
and platform information in the request.

Note Secure Messaging is supported without fixes in IBM Lotus Sametime 8.5.1.

Applying IBM Hotfixes for Lotus Sametime 8.0.2 (Secure Messaging Only)

Note The IBM hotfixes apply only to Lotus Sametime 8.0.2.

Do the procedure in this section only when secure messaging is configured.

To Apply IBM Hotfixes for Lotus Sametime 8.0.2 (Secure Messaging Only)

Step 1 Go to the IBM website and obtain the required cumulative fix pack: 
https://www.ibm.com/support/docview.wss?uid=swg21425033.

Step 2 Open a service request with IBM Support to obtain the fix pack as noted on the site. Include the version 
and platform information in the request.
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  Installation and Upgrade Information
Upgrading to Cisco Unified Messaging 8.5(1) with IBM Lotus Sametime
There is no separate upgrade process—you install the new version of the plug-in in the same way you 
installed the previous version. See the next section, “Installing Cisco Unified Messaging 8.5(1) with 
IBM Lotus Sametime.”

You do not need to uninstall a previous version. The update manager in Sametime handles it.

Installing Cisco Unified Messaging 8.5(1) with IBM Lotus Sametime
There are two ways in which to install the plug-in on user workstations:

• Automatic push update—See the IBM Lotus Sametime documentation for information on setting 
up an automatic push update. We recommend using this method.

(After the push update has been set up, continue with the “Configuring Cisco Unified Messaging 
8.5(1) with IBM Lotus Sametime” section on page 8.) 

Note IBM Lotus Notes does not support an automatic push update, but you can configure your 
installation to use a Notes widget to create similar behavior. You must first run the Cisco Unified 
Communications with IBM Lotus Sametime Configuration Tool and then follow the instructions 
at 
http://publib.boulder.ibm.com/infocenter/domhelp/v8r0/topic/com.ibm.help.domino.admin85.d
oc/H_CLIENT_MGMNT_OVER.html.

• Manual installation—Do the “To Manually Install the Cisco Unified Messaging with IBM Lotus 
Sametime Plug-in on a User Workstation” procedure in this section.

(After the software has been installed, continue with the “Configuring Cisco Unified Messaging 
8.5(1) with IBM Lotus Sametime” section on page 8.)

Note After the plug-in is installed, users may be required to enter their Cisco Unity or Cisco Unity Connection 
account information in their IBM Lotus Sametime client application. Instructions are provided in the 
User Guide for Cisco Unified Messaging with IBM Lotus Sametime Release 8.x, available on Cisco.com 
at http://www.cisco.com/en/US/products/ps9830/products_user_guide_list.html.

To Manually Install the Cisco Unified Messaging with IBM Lotus Sametime Plug-in on a User Workstation

Step 1 Start the IBM Lotus Sametime client application.

Step 2 From the Tools menu, select Plug-ins > Install Plug-ins.

Step 3 In the Install/Update wizard, on the Feature Updates page, select Search for New Features to Install 
and select Next.

Step 4 On the Update Sites to Visit page, select Add Remote Location.

Step 5 In the New Update Site dialog box, in the Name field, enter Cisco Voicemail.

Step 6 In the URL field, enter the URL of the update site that hosts the Cisco Unified Messaging with IBM 
Lotus Sametime plug-in and select OK.

Step 7 On the Update Sites to Visit page, select Finish.

The Updates window opens with Cisco Voicemail listed as a feature to install.
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  Installation and Upgrade Information
Step 8 Select Cisco Voicemail.

Step 9 If there is an IBM hotfix available, select the IBM hotfix.

Step 10 Select Next.

Step 11 Select I Accept the Terms of the License Agreement, and select Next.

Step 12 If a feature verification warning appears, select Install All.

Step 13 Select Yes to restart the IBM Lotus Sametime client application.

Configuring Cisco Unified Messaging 8.5(1) with IBM Lotus Sametime
In this section, you configure the Cisco Unified Messaging with IBM Lotus Sametime plug-in for all 
users who will use it.

You can use the Cisco Unified Communications with IBM Lotus Sametime Configuration Tool for 
updating user configuration information after the plug-in has been installed.

For configuration changes to take effect, either set up Sametime to update users automatically by using 
a push update, or instruct users to update the plug-in from their Sametime client.

This section contains two procedures:

• To Configure Cisco Unified Messaging with IBM Lotus Sametime by Using the Configuration Tool

• To Manually Configure Cisco Unified Messaging with IBM Lotus Sametime on a User Workstation

To Configure Cisco Unified Messaging with IBM Lotus Sametime by Using the Configuration Tool

Step 1 Go to directory that was created in the “To Download Cisco Unified Messaging 8.5(1) with IBM Lotus 
Sametime” procedure on page 5.

Step 2 Go to the ciscocfg directory.

Step 3 Double-click ciscocfg.exe.

Step 4 In the Choose an Update dialog box, in the Directory field, enter the path of the UpdateSite directory 
that was created in the “To Download Cisco Unified Messaging 8.5(1) with IBM Lotus Sametime” 
procedure on page 5.

Step 5 Select OK.

Step 6 In the Cisco Unified Communications with IBM Lotus Sametime Configuration Tool window, select the 
LDAP tab and enter values in the applicable fields. The fields are described in Table 1.

Note Configuration of LDAP is optional. However, choosing not to use LDAP may result in some 
diminished unified messaging functionality. For example, Cisco Unified Messaging with Lotus 
Sametime uses LDAP to map phone numbers from voice messages to Sametime contacts. 
Without LDAP properly configured, phone numbers or names may display in the Name column 
rather than Sametime contacts.
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  Installation and Upgrade Information
Note The default LDAP settings provided are representative of common configurations. 
Administrators should determine if these settings are appropriate for their specific 
configurations and change as necessary.

Table 1 Fields on the LDAP Tab

Name Description

Directory Server Settings

Server Enter the name or IP address of the LDAP server.

Port Enter the number of the port used to communicate with the LDAP 
server.

Search Base Enter the base (or root) of the directory service in which to search 
for names. The value must match the one configured on Sametime 
server. If LDAP is used for the directory service, you can derive 
the setting directly from there. If Domino is used instead, find the 
equivalent search base on its LDAP interface.

Display Name Attribute Enter the LDAP attribute that is used as the display name for the 
caller.

Attribute for Lookup in Sametime Enter the LDAP attribute that is used to search for the caller in 
Sametime.

Authentication Required Check this option if authentication is required by the server.

Authentication Credentials

Distinguished Name (When authentication is enabled) Enter the distinguished name 
that is used to authenticate with the directory service.

Password (When authentication is enabled) Enter the password that is used 
to authenticate with the directory service.
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Directory Usage

Non-default Community Access Enable non-default communities to use directory services to 
extend the functions to pilot communities, for example:

• Retrieve phone numbers to populate their contacts

• Show phone status for their contacts

Only one set of users data can be used. You can have two 
communities, but of the same global set of users. If the Sametime 
server for the non-default communities uses the same LDAP 
server as the default community, then identical functionality can 
be extended to contacts in those communities.

Select the applicable setting:

• Disable—Select this option so that non-default communities 
are unable to use the directory service.

• Enable for All Communities—Select this option so that all 
non-default communities are allowed to use the directory 
service.

• Enable for Configured Communities—Select this option 
so that only communities listed in the Community List field 
are allowed to use the directory service.

Community List (When Enable for Configured Communities is selected above) 
Enter the list of communities (Sametime host name or IP 
address), separated by commas, that you want to allow access to 
the directory service.

Directory Type for Sametime Server

Directory Type Enter the applicable settings:

LDAP—Select this option if the IBM Lotus Sametime server 
uses an LDAP server for directory service.

If IBM Lotus Sametime uses an LDAP attribute for the internal 
user ID, check the Use Attribute as Internal ID of Sametime 
User option and enter the name of the LDAP attribute.

Domino—Select this option if the IBM Lotus Sametime server 
uses IBM Lotus Domino for the directory service.

Refer to IBM Lotus Sametime documentation for additional 
information.

Table 1 Fields on the LDAP Tab (continued)

Name Description
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  Installation and Upgrade Information
Step 7 On the File menu in the Configuration Tool window, select Save.

Step 8 In the window, select the Voicemail tab and enter values in the applicable fields. The fields are described 
in Table 2.

Fields that remain empty do not overwrite the Cisco Unified Messaging with Lotus Sametime 
configuration on the client, but fields with values will overwrite the Cisco Unified Messaging with Lotus 
Sametime configuration when an updated feature is installed on the client workstation.

Dialing Rules Files

Application Dial Rules If you will use Application Dial Rules, enter the location of the 
dial rules file. You can obtain Application Dial Rules from Cisco 
Unified Communications Manager Administration by navigating 
to the Call Routing area.

Application Dial Rules automatically strip numbers from or add 
numbers to telephone numbers that Sametime Connect dials. For 
example, the dialing rules automatically add the digit 9 in front of 
a 7-digit telephone number to provide access to an outside line.

Note A file template is available in the templates directory 
where you extracted the Cisco Unified Communications 
with IBM Lotus Sametime Configuration Tool.

This field applies only when Cisco Phone Control and 
Presence is configured with Cisco Unified Messaging 
with Lotus Sametime.

Directory Lookup Dial Rules If you will use Directory Lookup Dial Rules, enter the location of 
the dial rules file. You can obtain Directory Lookup Dial Rules 
from Cisco Unified Communications Manager Administration. 
Navigate to the Call Routing area.

Directory Lookup Dial Rule transform caller identification 
numbers into numbers that can be looked up in the directory. For 
example, the dialing rules can automatically add +140852 to 
5-digit numbers beginning with 5, so that the number 56666 
becomes +14085256666.

Note A file template is available in the templates directory 
where you extracted the Cisco Unified Communications 
with IBM Lotus Sametime Configuration Tool.

Table 1 Fields on the LDAP Tab (continued)

Name Description
11
Release Notes for Cisco Unified Messaging Release 8.5(1) with IBM Lotus Sametime



  Installation and Upgrade Information
Table 2 Fields on the Voicemail Tab

Name Description

Mail Store Connection Settings

Server Enter the applicable setting:

• For Cisco Unity, enter the name or IP address of the 
Exchange or IBM Lotus Domino server.

• For Cisco Unity Connection, enter the name or IP address of 
the Connection server.

Port Enter the number of the port used to communicate with the mail 
store.

Note Cisco Unity Connection provides a port that enables 
license-free IMAP connections. To use this port, enter 
7993, and check the Use Encrypted Connection check 
box.

Use Encrypted Connection Check this check box to use an encrypted connection to 
communicate with the mail store.

Use Sametime Credentials Check this check box if the credentials for logging in users to 
IBM Lotus Sametime are the same as the credentials for 
connecting to the voicemail system.

Read Only Check this check box to prevent the user from changing these 
settings.

Poll Interval If the server supports IMAP IDLE, the setting in this field is 
ignored.

If the server does not support IMAP IDLE, enter the time, in 
seconds, that each client waits before checking for new voice 
messages.

Mail Store Folder Settings

Inbox Folder Enter the name of the voicemail folder in the IMAP store.

Move Deleted Voicemail to a 
Separate Folder

Check this check box if the mail store has a folder for deleted 
messages that is separate from the Inbox folder.

Trash Folder If the mail store has a separate folder for deleted messages, enter 
the name of the folder for deleted messages.

System Settings

Enable Connection to Voicemail 
Web Service Server

If secure messaging is configured on Cisco Unity, check this 
check box to enable the Voicemail Web Service server.

If secure messaging is configured on Cisco Unity Connection, do 
not check this check box.

Use Mail Store Server as Voicemail 
Web Service Server

(When the Voicemail Web Service server is enabled) Check this 
check box if the Voicemail Web Service server is on the mail store 
server that is entered in the Servers field under Mail Store 
Connection Settings.
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Step 9 On the File menu in the Configuration Tool window, select Save All.

Step 10 On the File menu in the Configuration Tool window, select Exit.

Caution Confirm that you have saved your changes in the Cisco Unified Communications with IBM 
Lotus Sametime Configuration Tool window. Otherwise, all unsaved changes will be lost 
when you close the window.

Step 11 For configuration changes to take effect, either set up IBM Lotus Sametime to automatically update users 
by using a push update, or instruct users to update the plug-in from their IBM Lotus Sametime client.

Server (When the Voicemail Web Service server is enabled) If the Use 
Mail Store Server as Voicemail Web Service Server check box is 
not checked, enter the name or IP address of the Voicemail Web 
Service server.

Protocol (When the Voicemail Web Service server is enabled) Select the 
applicable setting:

• HTTP—Select this option if message security is not used.

• HTTPS—Select this option if message security is used.

Port (When the Voicemail Web Service server is enabled) Enter the 
number of the port used to communicate with the Cisco Unity 
server.

LDAP Attributes

User ID Enter the LDAP user attribute that contains the user ID in voice 
messages so that a directory search can find and display the user 
name.

Phone Numbers Enter the LDAP phone attributes that contain the caller ID in 
voice messages so that a directory search can replace the phone 
number with the caller name on voicemail.

Voicemail Player Settings

Rewind Interval Enter the time, in seconds, that a message will rewind when the 
Rewind button on the Voicemail player is pressed.

Skip Forward Interval Enter the time, in seconds, that a message will skip forward when 
the Skip Ahead button on the Voicemail player is pressed.

Logging

Enable Detailed Logging Check this check box to enable detailed logging.

Caution Enable detailed logging only for troubleshooting. 
Otherwise, the logging will impact the system 
performance.

Table 2 Fields on the Voicemail Tab (continued)

Name Description
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  Limitations and Restrictions
The following procedure requires administrator-provided information.

To Manually Configure Cisco Unified Messaging with IBM Lotus Sametime on a User Workstation

Step 1 In IBM Lotus Sametime Connect, from the File menu, select Preferences.

Step 2 In the Preferences window, in the left pane, expand Cisco and select Voicemail.

Step 3 Under Account, if the following fields are blank, enter the applicable settings as your administrator 
instructs. Otherwise, skip to Step 4.

a. In the User ID field, enter your user ID.

b. In the Password field, enter your password.

c. In the Server field, enter the server name or the IP address of the mail store.

d. In the Port field, enter the port number used to communicate with the mail store.

e. Check or uncheck the Use Secure Connection check box.

Step 4 If you want Sametime to display an icon indicating unheard voice messages, check the Show Global 
Message Waiting Indicator check box.

Step 5 If you want Sametime to maintain a log to assist in troubleshooting issues, check the Enable Detailed 
Logging check box.

Step 6 Select OK to accept the settings and to close the Preferences window.

Limitations and Restrictions

Secure Messaging
Cisco Unified Messaging with IBM Lotus Sametime supports the secure messaging feature with Cisco 
Unity 7.0(2) and later, and Cisco Unity Connection 7.0(1) and later. The secure messaging feature 
provides security for voice messages by using public and private key encryption. 

IBM Lotus Notes Displays Dates In U.S. English Format
IBM Lotus Notes displays dates only in the U.S. English format when any English language is selected.

IBM Lotus Sametime Displays Dates In U.S. English Format
If users want IBM Lotus Sametime to display the date in a format for English other than U.S. English, 
do the procedure in this section.

The procedure applies only to IBM Lotus Sametime installed on the Windows and Mac operating 
systems. This workaround does not apply to IBM Lotus Sametime installed on a Linux operating system, 
or to IBM Lotus Notes.
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To Configure IBM Lotus Sametime to Display the Date in a Non-U.S. English Format

Step 1 On the user workstation, go to the applicable directory—depending on the operating system—and open 
the file:

Step 2 In the file that you opened in Step 1, make the applicable change:

Step 3 Save and close the file.

G.729a Encoded Voice Messages Cannot Be Played
Cisco Unified Messaging with IBM Lotus Sametime plays only voice messages encoded with G.711.

MWI on Phone Does Not Change to Reflect Message State
For environments with Cisco Unity and IBM Lotus Domino as the message server, IBM Lotus Sametime 
does not communicate changed message states so that Cisco Unity can change the message waiting 
indicator (MWI) on the phone. For example, the new-message light on the phone will not turn off after 
the message is played from IBM Lotus Sametime.

Deleted Messages Folder Is Not Supported If the Mail Store Does Not Support 
UIDPLUS

If the mail store does not support UIDPLUS, Cisco Unified Messaging with IBM Lotus Sametime does 
not support a folder for deleted messages that is separate from the Inbox folder. Voice messages in a 
folder for deleted messages on this message store has the following limitations:

• Moving voice messages to a folder for deleted messages does not turn off MWIs.

Windows Documents and Settings\<user>\Application Data\Lotus\Sametime\.config\
rcpinstall.properties

Mac Users/<user>/Lotus/Sametime/.config/rcpinstall.properties

Windows Change the line com.ibm.rcp.core.locale=en to one of the following:

• For Canada, enter com.ibm.rcp.core.locale=en_CA.

• For Ireland, enter com.ibm.rcp.core.locale=en_IE.

• For United Kingdom, enter com.ibm.rcp.core.locale=en_GB.

Mac At the end of the file, add the applicable line:

• For Canada, enter com.ibm.rcp.core.locale=en_CA.

• For Ireland, enter com.ibm.rcp.core.locale=en_IE.

• For United Kingdom, enter com.ibm.rcp.core.locale=en_GB.
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  Caveats
• IBM Lotus Sametime Connect shows the deleted voice messages by using the Deleted filter, but the 
phone user interface (TUI) lists the deleted voice messages as saved messages.

• Voice messages in the folder for deleted messages cannot be deleted or purged.

Update Sites
Older versions of IBM Lotus Sametime did not support simultaneous updates from multiple update sites. 
Selecting more than one update site and trying to install a feature caused a NullPointerException. This 
may have been fixed in newer versions.

Caveats
There were no Severity 1, 2, or 3 resolved caveats in Cisco Unified Messaging with Lotus Sametime 
version 8.5(1).

The following caveats have been resolved in Cisco Unified Messaging with Lotus Sametime version 
8.5(1).

You can find the latest caveat information for Cisco Unified Messaging with Lotus Sametime version 
8.5(1) by using Bug Toolkit, an online tool available for customers to query defects according to their 
own needs.

Bug Toolkit is available at www.cisco.com/go/bugs. Fill in your query parameters by using the custom 
settings in the Advanced Settings option.

Note To access Bug Toolkit, you must be signed in to Cisco.com as a registered user.

Release notes for all versions of Cisco Unified Messaging with Lotus Sametime are available at 
http://www.cisco.com/en/US/products/ps9830/prod_release_notes_list.html.

Troubleshooting Information
• Status Bar in Cisco Voicemail Application Panel, page 17

• Creating a Problem Report, page 17

• User Unable to Play Voice Messages Because of Port Conflicts, page 17

Table 3 Closed Caveats for Cisco Unified Messaging with Lotus Sametime

Identifier Severity Component Headline

CSCti49542 3 voice Sametime contact name changes after receiving VM from that person

CSCtb72626 4 voicemail Voicemails remain in local cache after abnormal Sametime exit
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  Obtaining Documentation and Submitting a Service Request
Status Bar in Cisco Voicemail Application Panel
The status bar at the bottom of the Cisco Voicemail application panel indicates when the user is 
successfully connected to Cisco Unity or to Cisco Unity Connection. Any error messages appear as 
hypertext links, which users can select to show information about the errors and how to resolve them.

Creating a Problem Report
If any unexpected or unresolvable issues occur, detailed logging information is available that can assist 
in troubleshooting.

To Create a Problem Report

Step 1 Locate your IBM Lotus Sametime logs files:

a. From the File menu, select Preferences. 

b. Open the Cisco tab on the left.

c. Under Cisco, select the Voicemail tab.

The Logs field shows the location of the IBM Lotus Sametime logs.

Step 2 On the preference page, check the Enable Detailed Logging check box. 

Step 3 Reproduce the problem, then select Create Problem Report to collect the log files.

Step 4 When prompted, enter the directory in which you want the problem report saved.

At this location, the problem report will be saved with a filename in the following format:

ProblemReport_Voicemail_<version>_<user ID>_<timestamp>.zip

User Unable to Play Voice Messages Because of Port Conflicts
If a user is unable to play a voice message and receives an “Error attempting to play voicemail” or 
“Unable to instantiate Audio Player” message, check the trace-log-0.xml file log file.

If the log file shows a bind exception, then the Voicemail Port may be in use by another plug-in.

To resolve this problem, change the Voice Chat Port number from the Sametime Administration Console 
on the Sametime server. For steps on how to change this port, refer to the Sametime Administrator Guide.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
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  Obtaining Documentation and Submitting a Service Request
Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed 
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free 
service and Cisco currently supports RSS Version 2.0.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of 
Cisco trademarks, go to this URL: www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The 
use of the word partner does not imply a partnership relationship between Cisco and any other company. (1110R)

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any examples, command display output, and 
figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses in illustrative content is unintentional and 
coincidental.

© 2011 Cisco Systems, Inc. All rights reserved.
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